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Chapter 1. INTRODUCTION 

This course will introduce you to the potential of the under-used features of your Excel 

software, to produce impressive graphics for insertion in your Process Flow Diagram (PFD) 

and any other spreadsheets. You will learn how to unleash your creativity and make your 

mundane engineering spreadsheet a work of art. 

“A picture is worth 1,000 words.” So says a proverb generally attributed to Confucius. This is 

certainly true in engineering, whether in internal communication or in final design documents.  

In chemical process design, this most certainly applies to any PFD which is the essential one-

view introduction and final summation to any plant design project. This kind of “flow sheet” 

consists of at least a diagram showing lines for all flowing materials, connecting pieces of 

equipment, which are drawn using “standard” symbols for all items with all flow lines numbered. 

This picture is usually combined with a table showing all flow parameters (flow rates, 

temperatures, pressures and composition) for each stream. This creation was traditionally 

drawn manually, but is now done using AutoCAD or other drawing software with standard 

symbols, including the table. Any revision or change of parameters requires that the PFD be 

redrawn for release or presentation. This requires man-hours and limits the immediacy of 

communicating changes.  

As a qualification to benefiting from this course, it is assumed that the reader is a graduate 

engineer (primarily chemical), with average spreadsheet proficiency in Microsoft Excel. For 

supplementary reading, one might consult the two volumes of “Excel for Dummies,” but those 

do not contain anything on the use of the powerful drawing feature which will be discussed in 

this course. 

Scope of Application: There are drawing software packages such a Visio, that provide flowsheet 

symbols according to a “standard” format that can be inserted into a spreadsheet and show all 

process calculations. There are expensive process simulation packages, available for licensing, 

such as Aspen HYSYS, which can presumably do most of a process design for you, including 

minimal standard flow diagrams. This course, however, is intended for the do-it-yourself 

chemical engineer, needing only a laptop with MS Office Excel, which everyone has. Some 

employers and clients may require flow sheets to be done in Visio or other such systems in the 

name of “uniformity” or “professional appearance.”  However, where you are allowed to make 

the best effort to deliver a flowsheet as visually explanatory as possible, such as to sub-

technical management. Remember that “You are the artiste”. Your flow sheet can be a 

masterpiece, and creating it can be fun! 

Here are some examples of what anyone can easily generate. 
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Example 1. This was a preliminary design for a small sewage treatment plant, using a trickling 

sand bed filter as the main bio-oxidation step. It was designed in multiple capacities for different 

communities. By selecting a community in the upper left corner, all of the process parameters 

change accordingly. Pending the owner’s requirements of formatting details and the certification 

of all numbers, this would be an impressive presentation of the product. 

 

Project Selection: Agua Prieta INPUT COMMUNITY / PROJECT NAME

Peak GPD 15000 FROM SELECTIONS BELOW. 2  SAND FILTER CELLS

Peak GPM 10 Agua Prieta

Avg GPD 8000 Poopsville LS 13.02 GPM AVG.

Avg GPM 6 Stinkton FLOW SPLITTER 175 GPM ACTUAL

No. of Cells 2 Limpiagua 2 AUTOMATED

Mierdapolis 3" BALL  VALVES

CYCLE CONTROL

BOD-1 = 0 80% 20% 15 Min Dosing

TDS-1 = 0 45 Min between.

TO EACH CELL.

Enter 1 for Avg. flow, or 2 for peak flow. 2 41.7 GPM GRAVITY FLOW. 10.4 MANIFOLD TO 2 SAND FILTERS.

RAW SEWAGE GPM 13.0 GPM  EACH

10.4 GPM  (24 HR AVG.) 2 2 COMBINED FLOW FROM SAND FILTER CELLS = 26 GPM

Initial BOD = 0 SEPTIC TANKS RECIRCULATION

FORCE MAIN Initial TDS = 0 26.0 GPM  TO TANKS A: Coarse rock distribution zone - 1 ft.

      6" PVC Floating EACH OF 2 5000 B: Bioactive sand layer - 2 ft.

grease RECIRC. TANKS GAL EACH UV DISINFECTION C: Pea rock collection zone - Avg. 9"

5.2 etc. *

GPM 6" 26.0 PUMP CONTROLS

PVC GPM

10.4 COMBINED

5000 GPM RETENTION 

GAL EACH 6.4

COMBINED HR

RETENTION =

16.0 2 PUMPS

HR Rated GPM

            LA 175

52.1 Average GPM

RETURN MANHOLE GPM 52

6" = 75,000    

* Sludge & floating layer FLAP VALVE PVC GPD

periodically pumped out ON EACH 19  Ft. GRAVITY FLOW OFF-SITE 10.4 GPM

for landfill disposal. TO DISCHARGE  MANHOLE To river

   PS

   EXAMPLE.  Quantities for illustration only.
RECIRCULATION STATION

Process Flowsheet for Wastewater Treatment by Gravel Filter (1 PUMP OPERATING - 1 STANDBY)

Duty Cycle 30% of time. Project No. 2003-7

Hauserman Associates, Inc. Flowsheet+      by  W.B.Hauserman, PE    
. November, '04

MANIFOLD VAULT
4"  PVC KNIFE GATE

VALVE IN LINE TO 
EACH
SEPTIC TANK.

Sludge*

A

B

C

CONFIDENTIAL 
Details of this process example represent a 
hypothetical, simplified  design only.      
Do not disseminate.
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Example 2. This was a conceptual design for a rotating, multi-hearth heater, for pre-roasting 

various oil seed products, as pretreatment for oil extraction. The feed stream of beans/grain 

flows radially inward and outward, across a rotating steam-heated surface, with streams of 

ambient air flowing across each hearth/pan, to carry out the vapor. It uses plant steam at 30 

psig, to generate lower pressure steam for carefully controlled heating of the solid product 

stream. As a result of being part of the process design spreadsheet, any change in user inputs 

(highlighted in pale green) updates all of the other parameters. 

 

GRAIN / BEAN HEATER WITH ISOLATED STEAM GENERATOR  (ISG)

Feed (Soybeans)

344500 lb/h HYPOTHETICAL EXAMPLE

Losses 68 oF Vessel

Air In 5% 11% Moisture Total crosexion = 117 ft
2

15500 SCFM 13.47 Mbtu/h  for Free f low  area = 68 ft
2

70    oF Heating & semi-drying. Tube bundles = 9

7 PSIG DT= 168 F Heat trans. area = 20124 ft
2

69750 lb/h Heat trans. height = 30 ft

1.172 Mbtu/h Working volume = 2739.6 ft
3

Number of tubes 3024

Air Out 140  oF

2.349 Mbtu/h

DH to Air = 1.177 Mbtu/h

DT= 96 10 oF

Total heat 140    oF 1.135 Mbtu/h 9.6% Moisture

req'd. = 15.37

Mbtu/h

0-15 PSI        

10 PSIG PC

PRV 236 oF PRV

Set 22 psi 1161 Btu/lb Set 45 psi Losses

13243 3%

PC Lb/h

30 PSIG

272 oF     LT       = Steam traps.

1171 Btu/lb

13513 Lb/h

15.83 Mbtu/h DT = 36 PSI Normal operating 

w ater level range.

Condensate return Emergency shut-dow n, or PC override.

to plant steam system.

User inputs highlighted in green. All other parameters are computed automatically.

ISG
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While artistically refined enough for final presentation, these were created initially as internal 

working documents, pending refinement of calculations and approval for release. 

Example 3. This example was put together rather quickly as a tutorial for some non-technical 

visitors to a new combined cycle power plant in St. Paul, MN, showing its typical operating 

conditions. 

 

HOW A TYPICAL COMBINED CYCLE POWER PLANT WORKS. TO STACK

MAXIMUM OUTPUT CAPACITY  = 580.0 MW ( For Xcel St. Paul Plant )
= 1978.96 Million Btu/hour

OPERATING PARAMETERS FOR ABOVE (MAX.) CAPACITY. 300  ºF
FUEL: NATURAL GAS.
HEATING VALUE OF GAS: 1,000            BTU per Cubic Foot
THERMAL CONVERSION EFFICIENCY: 60% BOILER FEED WATER

NATURAL GAS NEEDED 3,298,000     SCFH (Cubic feet /hour)
= 55,000          SCFM (Cubic Feet/Minute) HIGH

- At Standard atmospheric conditions. PRESSURE

MINIMUM AIR FOR COMBUSTION 9.5                CF Air/CF Gas STEAM

= 523,000        CFM 2000psi

1000ºF STEAM

TURBINE

    GENERATOR

NATURAL MAX.
GAS 220

AIR (HIGH PRESSURE) MW
INTAKE          BOILER

COOL
HIGH PRESSURE
AIR

VERY HOT
WATER SPRAY HIGH PRES,

COMBUSTION COMBUSTION

GASSES   1000ºF?

    GENERATOR CONDENSER
HOT LOW
PRESSURE
GASSES, TURBINE

1800RPM? EXHAUST.
   BOILER FEED WATER

MAX. 180 MW COMPRESSION EXPANSION RIVER

FROM EACH  GT 3600 RPM? CONBINED WATER

160~190 COMBUSTION  (GAS) TURBINE  (1 OF 2) TURBINE COOLING ELECTRICITY
180 MW PRODUCTION 220

FROM 2ND. GAS TURBINE (NOT SHOWN) 180 MW 580.0 MW MW

640Max
Flowsheet by Hauserman Associates, Inc.  

 

With these examples of what is possible with Excel Graphics, we will now proceed with the 

basic details of the creation process. Unlike most online courses, this one is of necessity a 

“hands-on” learning process. You will do exercises to duplicate given graphic “creations,” and 

then save them for future reference. Fully mastering these techniques requires following a 

manual and trial-and-error learning. Initially, you will be experimenting with your capabilities, so 

be generous with practice time and have patience. 

  



5 
 

Chapter 2. EXCEL GRAPHICS BASICS 
 

Navigating the Excel Tool Bar 

 

 

As background for this course, it is assumed that 
everyone is thoroughly familiar with most functions 
of Excel spread sheets. We will begin here with the 
less-well-known commands essential for creation of 
simple and complex graphics. To start, open an 
Excel spread sheet and look at your tool bar. If you 
have a recent version of Excel, click on Insert and 
then on Illustrations, and then, on the mini-drop-
down, click again on Shapes. If yours is an older 
version of Excel, like 1997, you will click directly on 
Shapes, without the Illustrations step.  
  
 

You will now get a long list of options, in 
multiple boxes, of which the most useful 
are shown here. To use these, click on 
your selection and insert on your 
spreadsheet. For example, select the 
arrow. It will appear in pale blue, as shown 
below.  

 

 
The arrow will have dots at each end (not shown here). 
These are handles, or grab points. Click and hold on 
either end, to swing the line around to whatever angle 
you may need it, and stretch it as needed.  

 

 

 

Then click on any part of the line to drag it around on your spreadsheet. Then click again on the 

arrow, to see a Format Shape drop-down menu, from which you will see Line and Fill. Select 

Line.  Then select the type of line, color, type of arrows and size of arrows, as applicable. For 

example, select: 2 pt., and dark red, for the result shown above. To hide the spreadsheet grid 

lines, > Home Tab > Font > the little pouring pitcher icon for cell background color, then select 

white. (As used in this course, “>” means “go to and click on.”) 

 

Now, back to Insert > Illustrations > Shapes, select the multi-line (      ) from the drop-down 

menu. You are now installing a long run of pipe on your PFD. Using the grids on your 

spreadsheet for alignment, click a series of corners to make the line go around any obstacle to 

arrive where it is going. At the end of the run, double click.  Here you have your “raw” line, in 

blue, below. Now, you can click on the line, click on Format Shape, and select the appropriate 

line type, weight and color – depending on what’s flowing through the pipe on your flow sheet. If 

the arrow above is right for your selection, then double click on it, then click the format paintbrush 

in the Home tab, then click on your new blue line, with the result shown below. When next 

clicked on, use the mid-point handles to stretch it to fit on your flow sheet. 
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`

  

 

 

 

When working on a PFD, you will need valves: > Insert > Illustrations > 
Shapes > in the lines box on the drop-down, again click on ---- 

 
This command is simply a multiple of the simple Line command. You click on 
any sequence of points, anywhere on your worksheet, to draw a series of 
connected straight lines. To end the series, double click on the last point. 
  

Repeating this, with the final click point back on the point where you started, 
will close the object, which automatically takes a solid fill. Now, using the grid 
of your worksheet for corners, draw the shape that you need. Then, click 
anywhere on your new object, and select line weight & color, and fill color. Now 
it is starting to look like the standard symbol for any valve. 
 

 

To make this a simple hand-operated valve: > Insert > Illustrations > 
Shapes. Select the plain line (do it twice). Then, using the handles at each 
end, arrange the lines to form a T shape, along with your valve. The valve and 
each line are now in position, but as separate objects. To convert it to a single 
object, simply click on it, and observe a change in the tool bar. Then click on 
the Drawing Tools Tab to see the tool bar below. In the arrange block, see 
Group, to see a mini-drop-down, with 3 choices: Group, Ungroup and 
Regroup.  

 

 

 

Click on your completed valve, and notice separate boxes around each of the 

three objects. Click on each one of them, then click on Group. Click again on 

Group on the mini-drop-down. Notice that your valve with the handle is now 

one object that can be moved around, rotated, and formatted as one. Copy it 

onto a new spreadsheet to start your collection of standard objects. 

But for this project, a simple manual valve won’t do! We next assume that we 
need a pneumatically operated control valve. 
 
Back to Insert > Illustrations > Shapes, and select the smoothly curved 
line. It works like the sequence-of-lines command used above, except that all 
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points are connected along a smoothly curved curve. 
 
Using this command, click points, to create and upwardly bowed line. 
 

 

Another way to do this would be to use the Arc command, from the Shapes 
drop-down. You will get a blue arc. With handles on both ends, you can 
extend the arc to any part of a full circle. Do this to make one that looks like 
you want for your valve actuator. Then > Format > Line > Weight > Color, 
as above. 

 

  
Adjust this curve so the ends match those of your T valve handle, drag and 
drop it in position. Then, holding down Shift key, click both this curve and 
your valve. Now > Drawing tools tab, > Group > Group on the drop-down. 
Now you have the standard flow sheet symbol for a pneumatically positioned 
valve. Save it to your separate sheet of “standard” symbols for future use. 

 

 
Looking at the flow-sheet table below the picture you are drawing, you see 
that the flow through this valve has a high coarse solids content, and thus 
needs a full-bore ball or plug valve. To make the standard symbol for a 
ball/plug valve, again > Inserts > Illustrations > Shapes and select the 
circle/oblong from drop-down. It is a circle or oblong, depending on how you 
stretch it. Format it with a solid white fill. 
 

 
 
 

Now size the circle until it looks right and place it over the center of the valve.  
Notice that the valve is still 2 objects with separate boxes. Hold down shift 
and click both boxes. Then > Drawing Tools > Group > Group and click. 
Then add this one to your collection of standard items for future use. 
 

 

Then, back up a step, separate these objects, and move the valve to the 
circle. This doesn’t look right at all, so do not save it! So before you Group, 
click on the circle and right click to show another long menu. In about the 
middle of it, click on “Send to front.” This puts the circle over the valve as 
above. Then again, > Group > Group to combine. The “Send to 
Front/Back” are critical when grouping objects. 

 
 

 
The dome-shaped top on the standard symbol for pneumatic control valve was 
conceived to suggest the usual diaphragm for vertical motion of the valve stem 
in a simple lobe or needle valve. But for pneumatic operation (rotation) of a 
ball or plug valve, a more complex actuator is needed, including a pneumatic 
piston and lever enclosed in a rectangular housing.   
 
You might want your symbol to look more realistic based on your professional 
experience with such complex valves. To achieve this, > Shapes and select a 
rectangle. Now, take apart your pneumatically operated valve using the 
Ungroup command on the drop-down. Then delete the curved dome and 
replace it with your rectangular pneumatic piston housing. Then re-assemble 
(Group) your valve. 
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Summary 
 

 So far, you have mastered the most important basic procedures (sequences of 

commands/clicks) to do simple Excel graphics. These are: 

 On Insert Tab > Illustrations > Shapes, select shape of your choice. 

 Use handles (yellow dots) to stretch, shrink, expand, contract or otherwise change your 

selected Objects. Grab (click on) your Objects, but not by handles, to drag around as 

needed or to superimpose in other Objects. 

 Use Group and Ungroup, from the drop-down to combine multiple objects that can then 

be formatted, dragged around, rotated or re-scaled as a single Object. 

 Click on your creation (yellow handles showing on corners of identifying boxes), right 

click for a drop-down menu, then > Format Object at the bottom of the menu.  From the 

new pop-up menu, use Line and Fill menus to select the line types, weights, colors, and 

other details to make the desired object. 

 To match formatting, double click on a completed object, then on Home Tab, double 

click on the little paintbrush icon, use it to click on every object you want to match your 

completed object. 

-------------------------------------------------------------------------------------------------------------------------------------------- 

Summary 

Insert > Shapes > Select Object(s) > Format > Assemble/Arrange > Bring to Front/Back > Group. 

Semantics: Each symbol/thing you create using the above techniques we shall define as a creation. The complexity 

of each creation can be defined by the number of different selections from the drop-down menu and the number of 

different fills. 

 
Exercise 1. 
 

You check the process conditions on the table just below your flow 
sheet on the same page and see that the content flowing through the 
valve you just created is over 400ºC! Few or no valve seals and 
packings will survive very long at such temperatures. So, you must 
upgrade your valve selection by adding a cooling water jacket. There 
is probably no “standard” symbol for this so you must create one that 
will clearly indicate how this contraption works. Do this using what 
you have learned so far. The diagram to the right is a suggestion on 
your main process stream with cooling water connected. Do you 
think it will work? Try to improve on it.  
 
(This creation so far required 5 selections from the drop-down and 
2 fills.)  
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Hint: When arranging/combining shapes on a worksheet separate from your product flowsheet, it 

easier to position things accurately if you do it on a large scale and then shrink your final grouped 

item to copy to your flowsheet. But when you substantially shrink an item, you will notice that the 

line size des not shrink. When formatting a complex grouped object, you may find that some of 

the formatting choices do not respond. So your final product may have much bolder lines than 

you intended, as in the above suggestion. To avoid this, format each pre-grouped object with 

finer line width. Similarly, line weights and arrow sizes may not respond to formatting after 

grouping.  

 

If you want to – or are required to – keep your flow sheet brief and 
simple, you can simply import “standard” symbol for everything. You can 
quickly find tables of these via the Internet to download and copy. To 
customize your flowsheet, making it even more illustrative/realistic for the 
reader, you can also insert complex illustrations or even photos easily 
copied from external sources. But with this skill, remember that you are 
the artiste. The flowsheet is your masterpiece and the degree of realism 
depends on how much information you are transmitting. 

 

  

https://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=2ahUKEwisgu2b3rvgAhXAFzQIHaoeDkcQjRx6BAgBEAU&url=http://www.nivzvalves.com/Products/Ball-valve/jacketed-ball-valve&psig=AOvVaw3La0Tn3Xf2W_h4cSk-8MLw&ust=1550251244689137
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Chapter 3. DRAWING PROCESS EQUIPMENT SYMBOLS 

With Excel, we do not aspire to do precise scaled drawings. It’s only designed for 

schematic, symbolic, or illustrative representations.   

But for neat and precisely aligned drawings, we use the worksheet’s normal grid. For 

example, your flow sheet needs a screw conveyor. To start, select again the multi-line shape 

and allow plenty of room on your grid as shown below.  

 

` 

 

Next, using the handles on the box around it, which cannot be inserted into Word documents, 

shrink it down to a more convenient size. It now looks too short. Simply copy it, then invert the 

copy. To do this, grab a handle in the middle of either side of the box and drag it completely 

through the object and out the other side, turning the object inside out and making a mirror 

image. Do this with the copy both horizontally and vertically as shown below. Then, using the 

Group procedure, join them together as a single long screw. Then, from Shapes, select a box 

and place it snugly around your combined screw, then Group as a single object. 

 

 

 

 

Since a conveyor must have a motor, we look through the Shapes drop-down and find the box 

with rounded corners, (as shown above) to group with rest of the product. While this quite 

adequate for usual/standard flow diagrams, we are considering presentation to sub-technical 

management and would prefer a little more visual realism. So, we next select from Shapes a 

plain rectangle, then again the arc shape that we used for the top of the pneumatic valve. 

Grouping these with the conveyor above, we now have what looks more like the actual 

machine. 

     

 

 
 

  

 

Now, consulting your initial process description or the table on your spreadsheet below your 

flow diagram, you are reminded that the content being conveyed also needs to be heated. 

Therefore, this conveyor is also a steam-jacketed heater. For this, you can simply select the 
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rectangle shape, format the fill to red (since steam is hot), overlay it with the conveyor, send to 

back, and group. (So far, this creation has used 4 selections and 2 fills.) 

 

 

 

 

As a necessary afterthought, we have also added the steam supply line and condensate return 

line with a steam trap. Now all your conveyor/heater needs is a temperature control loop on the 

steam supply. Exercise: Add a temperature control loop as shown below. 

 

 

 

 

 

Hint: In the example above, the standard thermocouple symbol is blank. 
For your finished drawing, it should be labeled TC. Excel graphics does not 
include letters, except in “Callouts” described later. So on your 
spreadsheet the TC will be simply typed in a space with the circle 
positioned over it.  

       TC

 

In your Shapes drop-down, you will find some simple shapes especially in the Flowchart block 

that are often used in simple PFDs. These are quite adequate for minimal identification of valves 

or vessels, for instance, where vessels are merely to contain something temporarily. But in our 

process design, we need an enclosed vessel to contain a slurry and some noxious vapors, and 

an agitator to keep the solids from settling while blending a batch of several components. Below, 

left-to-right are the series of steps to assemble such a vessel on your flow sheet. 

Minimal 
symbol for 
a vessel, 
direct from 
Shapes 
drop-down. 
 
 
 
 
 
 

Select multi-line       
and arc shapes. 

With      (multi-
line) can do 5-
point shape like 
so: 
 
 
Instead use 
            shape 
with the same 5 
points to make a 
convincing 
propeller:                
 
 
 

Copy the 
motor from 
your screw 
conveyor, add 
a shaft and 
combine, 
 
 

Now, put the lid on your tank 
and insert the mixer. 
 
 
 
 
 
 
 
 
 
 
 
This creation has used 3 
selections from the drop-down, 
plus the motor designed earlier. 



12 
 

So far all of the closed shapes used in this liquid with settling solids tank/mixer/reactor are all 

formatted as “no fill.” To fully indicate the purpose of this device, you can show something about 

its contents, which only partially fill the vessel. To do this, starting left-to-right below,  

Using multi-line to 
manually copy the partial 
shape of your tank, up to 
the liquid level, shown in 
red. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Then to format, select 
gradient fill. Explore 
gradient options, selecting 
direction, position & colors 
of your choice, for the 
liquid and settling solids. 
 
 
 
 
 
 
 
 
This will take some 
experimentation with the 
gradient options available, 

The format “no line,” 
and put the liquid 
neatly back in the 
tank.   
 
 
 
 
 
 
 
 
You can now start 
adding all the 
essential details for 
a stirred reaction 
vessel. 

Besides a ball valve drain, a 
man-hole for filling and a vent 
line. We have a level controller, 
driving the flow of whatever 
reagent is needed for the 
reaction. 

 

Exercise 1.  

Now let’s design an insulated fluidized bed reaction vessel which is as complicated as a vessel 

can get. Again, using the same basic steps as above, proceed from right to left as shown below. 

Use multi-line and arc 
to create a vessel, 
with white fill. For a 
perforated floor plate, 
use a rectangle, and 
from patterned fill, 
select on that looks 
like holes through a 
thick plate. Then 
group. 
 
 
 
 
 
 
 
 
 
 

Before adding the 
plate, copy vessel 
and enlarge by 
10~20%. Select 
patterned fill that look 
most like insulation. 
 

For adjustable 
penetrations 
through a vessel 
wall or insulation, 
show 2 lines. Add 
a rectangle 
between, with “no 
line” and white 
(invisible) fill. Then 
group. 

Finally, superimpose 
vessel on insulation, 
and then add 
penetrations as desired 
for the following result. 
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So far, this creation has used only 4 selections from the Shapes drop-down and 3 different fills.  

Now, to show the fluidized bed in operation, proceed as below, left to right. 

 

Again, using multi-line, 
partially trace the fluid bed 
to whatever depth you 
want to fill the vessel. 
 
 
 
 
 
 
 
 
From pattern fill, select 
whatever looks to you like 
the bed material. The 
available fills may vary 
with your version of Excel. 

Select no-line. Then, select 
the circle/ellipse to draw a 
bubble, with white fill and no 
line, so it’s invisible. Then 
superimpose on the bed. 
Then copy and paste as 
many as desired with various 
sizes and shapes. Then 
group.    

Finally, put the bubbly 
fluidized bed into your 
vessel, adjusting all 
dimensions to fit. Then 
group. 
 

 

Here we have used only one more selection from the drop-down, plus one more fill. 

Now that you have a detailed-looking symbol for a fluid bed reactor in your archives, take a look 

at the description of a design project you’re about to start. It calls for partial gasification of a 

slurry of sand and used drilling mud in crude petroleum and brine – a common pollutant found in 

puddles around oil fields. Using air for fluidization, it will burn enough of the oil to vaporize the 

rest plus all the water. Field tests report peak bed temperatures of 1000ºC to 1200ºC, with hot 

gas/vapor going to a waste heat boiler to generate clean steam. So, the above symbol means 

that outer surface is your steel tank, with a thick layer of refractory brick on the inside. Do you 

want to use this “standard” symbol for 2 different process units – or create a different one for the 

high-temperature refractory-lined vessel?  

 

Exercise 2. 

Start assembling your own chosen menu of “standard” symbols to use in tour flow sheets. Start 

creating your own Excel sheet of these symbols. It may take you several minutes, to create some 

of these symbols, but once created and saved it only takes seconds to copy and paste onto a 

flow sheet. Using the simple techniques you have just mastered, create some generic heat 

exchangers from the following table and save them. For simple centrifugal pumps, see below 

how a range of configurations are simply created from 4 basic shapes. Your Excel reference 

sheet will the immediate useful tool acquired from this course. 
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………………………………………………………………………………………………………………………………….…… 

Summary. 

Select simple shapes > Arrange to build equipment items > Send to front/back > Group. 

………………………………………………………………………………………………………………………………………… 

Your “menu” sheet should include a few, simple arrows pre-formatted in most useful weights, 

colors and arrow size and kind so that the process lines on your flowsheet can be quickly 

formatted by sampling using the paintbrush icon on your Home tab. 

On your Format Shape drop-down, the selection of Pattern Fill and Gradient Fill options may 

vary between different versions of Excel. In the current/recent version, gradient fills are more 

complicated and less user-friendly than in earlier versions. 

 

Exercise 3. 

Here is a simple, shell-and-tube, low-shell-pressure heat exchanger made of only 3 items from 

the Shapes drop-down. Improve it for higher pressure use using the 4 components shown.  

Format nozzles and tubes with white/invisible fill. The nozzles can be arranged depending on 

the intended application: heating/cooling or condensation. Formatted nozzles and tubes should 

be on your reference sheet.  

 
 
 
 
 
 
 
 

This creation will use 5 selections from the Shapes 
drop-down and 2 fills. 
 
 
 
 
 
 
 
For single tubes, use a line, of weight 10 or higher, 
framed by 2 lines of weight 2 or 3. Then color the 
wide line white (invisible) after grouping. 
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Exercise 4. 

Here are two more common symbol to create for heat exchangers, plus a cyclone separator. 

You can/should consider whether to use different line weights for the shell and tubes.  

 

This creation, though 
complicated, should 
use only 2 selections 
from drop-down and 
no fills. 

 
 
 This creation requires 3 
Selections, one extra wide 
line weight and one fill.  

This quick, simple  
Creation requires 
only 2 selections  
And one fill. 

 

Reminder: Add all results of these exercises to your Excel reference sheet for potential future 

use. Make variants of each and tinker with them for improved neatness. Practice! 

 

Exercise 5. 

Now for some real creativity: 
From your extensive process design experience, 
you know what a plate type heat exchanger 
looks like and how it works. But how do you 
show one as a simple symbol on a flow sheet? 
Invent one! To this, there is no “correct” 
answer. 
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Dimensioned Drawings in Excel? 

Exact dimensioned drawings are not possible 
in Excel. For these, you normally use 
AutoCAD, SolidWorks or other equivalent 
software. If you are unable to use those 
software, you can do near-accurate freehand 
drawings that are quite adequate for 
presentation and preliminary layout of 
equipment whose dimensions are established. 
This is quite simple. 
1. Start with a new worksheet. Stretch the 

horizontal scale of cells to match the vertical 
scale, so all cells are exact squares. Define 
your scale. 

2. Copy-paste your equipment symbol into the 
new worksheet. 

3. Then stretch/shrink its dimensions to 
selected values, as defined by your scale. 

4.0 ft

Scale:   6"

6.5ft

T =1200ºC

 
 

Individual square cells may be too small to show working numbers. When you enter actual 

dimensions, they must be preceded with an apostrophe: ‘6.5 ft. The numbers and units can thus 

span multiple cells. Alternatively, you can merge several cells, to make a single cell long enough 

to accommodate a “live” number or equation result, linked from your process calculations on 

other sheets in the same project workbook. An example is the reactor temperature, shown in red 

above.  
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Chapter 4. ASSEMBLING THE FLOW SHEET. 

Until a plant is built, operated, and signed off by engineers, the design is in a continuous 

state of revision. The traditional flow sheet is created by drafters, with frequent (sometimes 

daily) manual revision as process calculations are refined and engineers proceed from 

estimates to firm/final numbers. Whether they are done by hand or on AutoCAD, revisions take 

time and man-hours. As equipment specs are developed, selections vary as minor details are 

refined. In conventional practice, a PFD will normally contain the following items: 

 Major equipment items  

 Principal process control functions (e.g. pressure, level, flow control) 

 Connections with other systems 

 Major bypass and recirculation (recycle) streams 

 Operational data (temperature, pressure, mass flow rate, density, etc.), often by stream 
references to a mass balance. 

 Process stream names 

Process flow diagrams generally do not include:  

 Pipe classes or piping line numbers 

 Instrumentation details 

 Minor bypass lines 

 Isolation and shutoff valves 

 Maintenance vents and drains 

 Relief and safety valves 

But within the scope of this course, what is normally done is of little concern. The intent here is 
for you – the Artiste – to make a flowsheet look however you want it to, but to be as informative 
as possible to any viewer.  

 

Example 1.  

The following is Page 2 of 8 pages (panes), of one big preliminary spreadsheet. Page 2 is part 

of a process to make high-purity carbon monoxide. The carbon monoxide was to be used to 

make phosgene, which, apart from its infamy as a military weapon, is in turn used to make 

polycarbonate plastic. The first step was the catalytic reforming of purified methane from natural 

gas by the desired reaction: CH4 + O2 = CO + 3H2, with undesirable side reactions yielding CO2, 

and dilution by N2 from air. Page 2 shows just the steam-methane reformer and some 

exchangers to recover the heat of reaction, while subsequent pages (not shown) deal with 

separation/purification of the product CO. This flow sheet was the initial/preliminary process 

design used for weekly or even daily communication between several engineers working at 

separate remote locations. For heat exchangers, it uses the simplest generic symbols for as-yet 

undefined equipment selections. For the catalytic reforming reactor using recycled hydrogen for 

heat, some ingenuity with Excel graphics was used in the absence of a “standard” symbol. Note 

that for each line, temperature, pressure and flow rates are shown in boxes linked to the table 

below. At this point, assuming engineers’ joint confidence in their calculations to date, this flow 

sheet would provide data for an equipment list and initial (for estimates) equipment specs. It is 

shown here as a good example of linked graphics and flow sheet data as a quick and easy 

https://en.wikipedia.org/wiki/Process_control
https://en.wikipedia.org/wiki/Temperature
https://en.wikipedia.org/wiki/Pressure
https://en.wikipedia.org/wiki/Mass_flow_rate
https://en.wikipedia.org/wiki/Density
https://en.wikipedia.org/wiki/Mass_balance
https://en.wikipedia.org/w/index.php?title=Pipe_class&action=edit&redlink=1
https://en.wikipedia.org/wiki/Valve
https://en.wikipedia.org/wiki/Relief_valve
https://en.wikipedia.org/wiki/Safety_valve
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communication tool. All data shown on the graphic portion is automatically up-dated with every 

minor design calculation. 

 

STEAM REFORMING FURNACE AND HEAT RECOVERY

102 104 105 110 111 109

15.2 Barg 14.2 Barg 14.2 Barg 106 1.11 Barg 1.11 Barg 14.2 Barg

15.7 ºC 174 ºC 364 ºC Unassigned 15.7 ºC 15.7 ºC 43.3 ºC

1078 kg/h 5803 kg/h 5803 kg/h 521 kg/h 22303 kg/h 4025 kg/h

101 70.68 Mcal/h 1668 Mcal/h 2021 Mcal/h 512.1 Mcal/h 1561 Mcal/h 819.8 Mcal/h

15.2 Barg 102
15.7 ºC    CO2   H2 110

1457 kg/h

232.6 Mcal/h Air

112

To Reformer 103 STEAM 113 1.01 Barg 120

via Preheater 14.2 Barg 1.013 Barg 15.7 ºC 3.04 Barg

198 ºC    FLUE 1930 ºC 22824 kg/h 30.15 ºC

3269 kg/h       STACK    GAS 22824 kg/h 2072 Mcal/h 452340 kg/h

1025 Mcal/h 19407 Mcal/h 135756 Mcal/h

117 114 108 121

0.83 Barg 1.013 Barg 14.2 Barg 2.668 Barg

232 ºC 1195 ºC 232 ºC 33.8 ºC

22824 kg/h 22824 kg/h 5803 kg/h 452340 kg/h

3438 Mcal/h BFW 12103 Mcal/h 1883 Mcal/h 137527 Mcal/h

118 119 116 122

14.2 Barg 14.2 Barg 0.865 Barg 115 107 123 15.2 Barg

15.7 ºC 199 ºC 1105 ºC Unassigned 14.2 Barg 15.2 Barg 15.71 ºC

10070 kg/h 10070 kg/h 22824 kg/h 899 ºC 202 ºC 3946 kg/h

2878 Mcal/h 3163 Mcal/h 11223 Mcal/h 5803 kg/h 3946 kg/h 1128 Mcal/h

4707 Mcal/h 1267 Mcal/h 124

147 RAW PRODUCT GAS 14.19 Barg

kg/h 43.29 ºC

1778 kg/h

557 Mcal/h

Methane - Steam Reformer
Basis of Sesign: 10% loss of CO in dowmstream purification operations and 20% overdesign

2,252 Kg/Hour ( 4,964 lb./Hour)  Carbon Monoxide in stream # 109 going to CO2 Absorber

Stream # 101 102 103 104 105 107 108 109 110 111 112 113 114 116 117 118 119 120 121 122 123 124 122 123 124

Description Methhane

Carb

on Steam

Feed 

to 

Feed to 

Reform

Product 

from 

Produc

t from 

Prodc

t from 

Fuel 

(H2) to 

Air to 

refor

H2-

Air 

Combu

stion 

Combusti

on gases 

Combu

stion 

Comb

ustion 

Boiler 

Feed 

Steam 

(From CWS CWR

Boile

r 

Stea

m 

Wate

r 

Boiler 

Feed 

Steam 

(From 

Wate

r 

ID in Aspen 101-CH4102-CO2103STEAM104FDPRH105FDHYC107HOTPR108CLDPR109DRYPR110-H2 111-AIR112H2AIR113CMBGS114FLUOU116FLUGS117FL450118BLRFD119STEAM120-CWS121-CWR 123STEAM124H2O 123STEAM124H2O

Stream From Header

CO2 

Strip

Steam 

Heade Headers

Feed 

Prehea

Reform

er

Boiler-

2      

Produ

ct 

Downst

ream 

Blowe

r

Blowe

r/         

Reform

er 

Reformer 

Shellside

Feed 

Prehea Boiler

Boiler 

feed Boiler

CWS 

Head

Reforr

mer 

Boile

r 

Boiler-

2

Refor

rmer 

Boiler 

feed Boiler-2

Refor

rmer 
Stream To Feed Fee Feed Feed Reform Boiler-2      Produc CO2 Reform Refor Refor Reform Feed Boiler Comb Boiler Steam Reforr CWR Boile Stea Sewe Boiler-2 Steam Sewe

Phase: Vapor VaporVapor Vapor Vapor Vapor Vapor Vapor Vapor Vapor Vapor Vapor Vapor Vapor Vapor Liquid Vapor Liquid Liquid

Liqui

d Vapor

Liqui

d Liquid Vapor

Liqui

d

Component                                         Mol. Wt.

CH4 kg/h 1455.4 1455 1455.4 148.4 148.4 148.4

H2O kg/h 3268.6 3269 3268.6 1781.3 1781.3 3.2 4629 4629 4629 4629 10070 10070 ##### ##### 3946 3946 1778 3946 3946 1778

CO kg/h 2251.5 2251.5 2251.5

CO2 kg/h ### 1078 1078.0 1125.9 1125.9 1125.9 3 3 3 3

H2O kg/h 494.90 494.90 494.90 494.90 495

N2 kg/h 1.28 1 1.28 1.28 1.28 1.28 17132 #### 17132 17132 17132 17132

O2 kg/h 5171 5171 1060 1060 1060 1060

Waste kg/h Waste products for fuel. 26.30 26.30

Check kg/h 1457 ### 3269 5803 5803 5803 5803 4025 521 22303 #### 22824 22824 22824 22824 10070 10070 ##### ##### 3946 3946 1778 3946 3946 1778

Flow kg/h 1457 ### 3269 5803 5803 5803 5803 4025 521 22303 #### 22824 22824 22824 22824 10070 10070 ##### ##### 3946 3946 1778 3946 3946 1778

Flow Mols/h 90.76 ### 181.44 ##### 296.69 459.64 459.64 360.93 258.55 ##### 1032 903 903 903 903 559 559 25108 25108 #### ##### 98.70 219 219 99

Liquid L/min 168 7553 7553 #### 29.69 66 30

Vapor SL/min 81 ### 67738 ##### 110764 171597 ##### ##### 96524 ##### #### 337213 337213 337213 ##### ##### 81779 81779

Vapor L/min 2171 547 7076 10666 17013 49210 20975 10831 48660 ##### #### ###### 906640 918410 ##### 21709 7834 7834

PressureBarG 15.2 15.2 14.2 14.2 14.2 14.2 14.2 14.2 1 1 1 1 1 1 1 14 14 3 3 15 15 14 15 15 14

T ºC 15.7 15.7 198.0 174.4 364.0 899.0 232.3 43.3 16 16 16 1930 1195 1105 232 16 199 30 34 16 202 43 16 202 43

MolWt kg/Mol 16.0 44.0 18.0 19.6 19.6 12.6 12.6 11.2 2 29 22 25 25 25 25 18 18 18 18 18 18 18 18 18 18

Densitykg/m
3

11.18 ### 7.70 8.67 5.69 1.97 4.61 6.19 0.18 2.56 1.87 1.09 0.42 0.41 1.11 998.00 7.70 ##### ##### #### 8.20 #### 998.00 8.20 ####

ViscosityCp 0.01 0.01 0.02 0.01 0.02 0.03 0.02 0.01 0.01 0.02 0.02 0.05 0.05 0.05 0.02 0.80 0.02 0.80 0.79 0.80 0.02 0.80 0.80 0.02 0.80

Cp kcal/kgºK 0.55 0.23 0.67 0.64 0.55 0.69 0.64 0.64 3.40 0.24 0.31 0.39 0.36 0.36 0.30 0.99 0.67 0.99 0.99 0.99 0.68 0.99 0.99 0.68 0.99

k kcal/h-m-ºK0.03 0.02 0.04 0.04 0.04 0.19 0.09 0.08 0.14 0.02 0.04 0.15 0.10 0.10 0.04 0.25 0.04 0.25 0.25 0.25 0.04 0.25 0.25 0.04 0.25

Heat DutyMM kcal/h -0.73 -6.296 17 -3.56 -6.404 -2.53 -2.526Heat 

Lost 122 123

 

 

Exercise 6. 

Now you will use some of the equipment symbols created in Chapter 3 in a ‘hypothetical’ 

example. Your new project specifies a 1000 kg/hr feed stream of waste materials consisting of 

about 20% of solids including some valuable recoverable components in a slurry with about 

40% of waste oil and 40% of an aqueous phase heavy on soluble salts. You need to recover the 

solids and as much of the combustible component and energy as possible. The preferred 

process sequence will start with a pressurized fluid bed reactor, in which part of the oil phase is 

burned, providing heat to vaporize the rest plus all the water. As an ‘exercise’, copy and paste 

the components you have designed above on a new Excel work sheet and connect with flow 

lines.  This may take you a couple of hours. Below is a possible/suggested “Revision 0” result. 

This will use all of the skills you have learned so far. If this were a classroom course, this 

exercise might be your final exam. 
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COOLING WATER

kg/h

HOT GAS/VAPOR ºC

m
3
/h

kg/h      PC

ºC       ??
Atm      TO VENT/FLARE

FEED SLURRY
1000 kg/h

TC       LOW PRESSURE PROCESS STEAM 

kg/h

Atm

ºC

    LC

ºC

Atm

    LC

    TC
FOR FLUIDIZATION

AND PARTIAL

COMBUSTION.

AIR
RECOVERED OIL PRODUCT

m
3
/h kg/h

kg/h

ºC kg/h

HOT SOLID RESIDUE    COOLING WATER

kg/h         SYSTEM WASTE WATER TO DISPOSAL

ºC kg/h

BOILER FEED 

WATER SYSTEM

kg/h

kg/h

kg/h LEACHING REAGENT

ºC kg/h

  SLURRY TO SEPARATION
kg/h

ºC

FORGOT SOMETHING?  

WE NEED A CYCLONE 
HERE, TO RECOVER 

DUST FROM THE GAS 
STREAM!

 

This looks good, and relatively ready to incorporate into a worksheet with process parameters 

as soon as you receive some data. Knowing or assuming a calorific value (HHV) and heat of 

vaporization for the “oil” and a credible heat capacity for the solids, you can estimate the amount 

to be burned to vaporize the rest, the air consumption, and flow rates of all product streams as 

per normal process design. (It was your Client’s specification that the 

combustion/gasification/pyrolysis step has to be pressurized, and that the primary heat recovery 

tubes ne incorporated into the reactor). You can now do a conventional HMB (Heat and Material 

Balance) to establish that the process is workable, to be updated as soon as firm data is 

provided.  

But as a process engineer, you have experienced normal “mission creep” as you recognize 

more components that will be needed. It was immediately obvious to you that once the vapors 

are all condensed, you will need an oil-water separator. Since you do not have a symbol for one 

in your reference archives, you used your new skills to design one. Creating it required 3 

different selections from the shapes drop-down, 2 different fills, and one item from your archive, 

with 2 different fills. As a process engineer, you also immediately saw the need for, and added, 

auxiliary systems (cooling water and boiler feed) and essential instrumentation and process 
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control loops. You added the data boxes, but they are left blank, because you have not yet 

computed the flow rates nor received firm composition data from the Client. Since this is only a 

course on the use of Excel graphics, such process data is “beyond the scope of this work”. 

Assume that you forgot to include a major essential piece of equipment: A cyclone to remove 

carried-over dust from the hot vapor stream, which would foul the tubes in the condenser carry 

through in the recovered oil product and waste water. But you designed a cyclone in Exercise 4, 

so you can add it to your product above with some rearranging of the piping. Also, you could 

have added a vent line and valve from the lock hopper, between valves, to the vent/flare line. 

(However, this is not a course on process design.) 

An actual process that could have been used for this example was one in which the feed slurry 

was a noxious pollutant that sometimes accumulates in puddles around oil fields. Such a 

composition was used in an encouraging pilot operation, which was as follows. Slurry feed rate: 

About 100 kg/h. Waste crude petroleum: 50%, HHV= 80,400 kcal/kg. Salty brine:  30%. Solids 

(sand, rock dust and used drilling mud): 20%. Reactor and vapor temperature: 1200ºC.  

Pressure: Ambient. All of the oil was burned resulting in high temperature, with intent to 

maximize available process heat with no liquid recovery. Dry cooled solids were disposed of to 

landfill with no value recovery. If this case had been used, Exercise 6 would have been too 

simple, not using enough of your experience from Chapters 2 and 3. The lock hopper, cooled 

valves, liquid separator, and solid product leaching vessel would not have been needed. For 

such a process, would you consider the symbol for the pressurized reactor vessel, which you 

just created, descriptive enough for a high temperature gasifier? If not, another exercise is in 

order. 

 

Exercise 7. 

To indicate a gasifier, with temperatures as high as possibly 
1200ºC, you need to emphasize that the inner surface is a 
rather thick refractory brick wall, inside the steel shell. So- 
1.  Retrieve your insulated fluidized be reactor from your 

archive sheet, and take it apart (ungroup). 
2. Separate the bottom/back layer, which shows the 

insulation pattern. 
3. Stretch it horizontally by 10~20%. 
4. Format the border lines, to 4- or 5-point width. 
5. Now put it all back together and regroup. 
Now you have a composite object that looks like a gasifier, 
albeit perhaps not an optimum design, with a thick 
refractory lining inside a sturdy steel vessel. Save it. This 
exercise shows the time-saving value of redesigning items 
from your “junk yard” (Archive sheet) create new 
equipment. 
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Example 2. 

Finally, we shall once again consider the usefulness of Excel graphics for quick informal working 

documents. Consider the following scenario:  

Engineer Mike is out in the field, far from Engineer Steve who is developing the PFD and 

defining numbers for equipment specs. Mike at least has a camera, as he pokes around the old 

plant, discussing its performance with operating staff and identifying possible problems. Shown 

below is a cut from a fairly long, quickly-constructed “walk-thru” Excel flowsheet, with imbedded 

photographs showing much of the existing equipment. On it, Mike has added notes citing his 

concerns. For these comments, the most useful tool here is the Callout, at the bottom of the 

Shapes drop-down. To use it, simply select from menu, click anywhere on the spread sheet, 

and drag the corner dot to define an area. At the end of the pointer, a yellow dot is the handle, 

to put the tip exactly on your point of interest. Then Format Shape, to select a white fill, with 

Lines and text in any color, and start typing the comment, which will at first be white/invisible. So 

highlight and edit the comment and select color and font style to identify the one making 

comments. Mike has added his current comments for his daily email back to the office. 

PYROLYSIS PRODUCT VAPORS AND GAS

TO HEAT RECOVERY AND STACK.

HOT COMBUSTION GAS FROM FURNACE

14.   PYROLYSIS REACTOR  PIPES, BETWEEN 
DRIVE BOX (LEFT) AND FURNACE (RIGHT). 
DRAG CHAIN INSIDE OF PIPES,

13.  CHIP FEED TO 
PYROLYSIS REACTOR.

16.   HOT CARBON PRODUCT FROM 
REACTOR TO COOLING SCREW.

17.  CARBON 
PRODUCT LOCK 
HOPPER.

Cooling 
screw too 
short. need 
more 
cooling 
capacity. To 
make 
longer, 
need to
reorient, so 
end is 
higher, next 
ro reactor.

Mike i

Valve gaskets 
have problem 
with 
overheating. 
Need different  
valve, with 
cooling jacket.

Mike

 

Meanwhile back in the office, Engineer Steve is overhauling the current flow sheet, a different 

part of which is shown below. 
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SHEET 2 OF 8

S-024

SPRAY QUENCH

S-034 S-080

CONDENSOR

TANK

S-087

S-026     Non-Condensibles to boiler fuel.

S-027

   PRECOOLER TO BE REDESIGNED.

    SECOND S-029

       OIL 

S-028    STORAGE

      TANK S-030

S-035

S-021 S-033

S-032 S-031

HOT VAPORS 

FROM REACTOR

S-082 S-089 S-083 S-090

LINE NO.,     S- 021 022 023 024 025 026

Description Hot  

Vapors

Cooled 

Vapors
Gas Light 

Oil

Temp, ºC 450

Temp.,ºF 842

Pres.  Bar  (1 Atm = 0) -0.12 Operating Pressure Propeietary.

Pres., psia 12.936

of NCG (incl. condensate) Flow, kg/h 238.4

Flow,  lb/h 525.672

Gas  Vol flow, Nm3/h

Liq. Vol Flow, Nm3/h

HHV, kcal/kg 10663.2

Liq. Heat Capacity, Cp, kcal/kgºC0.51335

Vap. Heat Capacity,Cp, kcal/kgºC0.3506

Solid HeatCapacity,Cp, kcal/kgºC-

Heat of Evaporation, kcal/kg 76.0203

Enthalpy, kcal/kg  (=Cp x (T-T0))147.252

Max. BP, ºC      Approx 600

Min. BP, ºC       Approx < 0.0

Steve-
What are your 
ideas for needed 
redesign of this 
precooler area?          
Mike. 
-------------------------

PLATE HEAT EXCHANGER 
ADDED AFTER CONSTRUCTION.  
BOTH EXCHANGERS TO BE 
REPLACED BY SINGLE BIGGER 
ONE,  RECOMENDED  BY PLANT 
OPERATORS.                      Mike

ANALYSIS OF FUEL GAS SHOWS 
ABOUT 50% WITH BP  < 100ºC.
TOO MANY CONDENSABLES LEFT IN 
VAPOR.  COOlING CAPACITY SHOULD 
BE INCREASED TO RECOVER MORE 

LIQUID PRODUCT.                       Mike

BELOW GRAPHICS, REST OF SPREADSHEET IS 
CONVENTIONAL TABLE FOR PROCESS FLOW 
DIAGRAM, EXTENDED INDEFINITELY BELOW FOR 
HEAT AND MATERIAL BALANCE AND ANY OTHER 
PROCESS CALCULATIONS.

Symbol looks like actual 
condenser in plant and 
shoen on as-built 
drawings.              Steve

 

Steve is working from a simple, earlier, client’s flowsheet and as-built drawings and some old 

operating data (details are proprietary). Some of Mike’s earlier comments are added in green 

callouts. Steve is selecting the best symbols – standard or custom – for the equipment 

components. For the condenser, he has used a custom creation from Chapter 2 because it 

simply looks like the real unit in the plant. However, he has concerns as to whether this is 

actually the best kind of heat exchanger for this application, which he expresses in his callout 

comment in purple. Apparently, the Client and plant operators agree that the old pre-cooler, 

before the spray quench, has room for some major improvements. 

In response to Mike’s last transmission of the draft, 
with his question about an apparently malfunctioned 
area of the process, Steve simply adds his comment 
to the expanded Callout with different script and color 
to avoid any confusion to others, such as Jack who 
will shortly have the design challenge dumped on 
him by e-mail. Though completely unfamiliar with the 
project, and possibly at a different office, Jack will 
have this complete picture of it, along with all the 
data he may need. While this flow sheet is still far 
from a final product, it is a complete, one-view 
description of the evolving process, for 
discussion/contribution by all participating members. 

PRODUCT VAPOR QUENCH AND CONDENSATION  FOR SINGLE REACTOR LINE.

THERMAL

EXPANSION

BELLOWS 

S-023

SPRAY

QUENCH

TANK

S-025

S-021 COOLED OIL TO    FIRST

PRE-COOLER      OIL 

SPRAY  STORAGE

   TANK

Steve-

What are your ideas for 
needed redesign of this 

precooler area?          Mike. 
-----------------------------------
Mike -
I'll pass on to Jack, He 
designed  something like 
this on a project a couple 
of years ago.                                                              
Steve    

 
 


